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Introduction

Trnseport and the Trnseport Suite of Software

Trnseport is the American Association of State Highway and Transportation Officials
(AASHTO) information system for managing transportation programs. Info Tech, Inc.,
developed Trnseport in 1982 to help state highway agencies and attorneys general with highway
construction bid collusion and anti-trust investigative efforts. Since then, InfoTech has added
significant additional capabilities to provide operational and management information support
for State Departments of Transportation and other construction contract activities. Activities
include management-level decision support; project cost estimate and proposal preparation, bid
letting and award management, and construction contract management. In October 1985,
AASHTO purchased Trnseport for licensing to all member agencies to share in the continued
development and use of Trnseport software. Of the nine Trnseport and Trnseport related software
modules, the Department is using seven. Their relationships are shown in Figure 1 on the next

page.

Trnseport BAMS/DSS (Decision Support System) provides a complete historical database of
construction contract information, a set of analysis models, and the capability for ad hoc query
and analysis. The BAMS/DSS module provides a fully integrated management decision support
system for highway agencies. The Trnseport BAMS/DSS applications include executive
information requests, summary reports for management, bid management and monitoring
analyses, market analyses and cost indices, project planning, project cost estimation, and
legislative presentation.

Trnseport CES (Cost Estimation System) provides Department estimators the means by which
to produce various types of Job estimates such as parametric, cost-based, and bid-based
estimates. Predefined and ad hoc formulas can be incorporated in the estimating process, and
users can assign funding and program information to CES Jobs. The Trnseport CES module
works in combination with the BAMS/DSS module to produce accurate, historically based
estimates. It also works in conjunction with the PES module, sending and receiving project and
proposal data that aids in the production of Job estimates.

Trnseport PES (Proposal and Estimates System) provides Department design, contract
administration, and estimating staff with a computerized tool to help with project definitions,
project cost estimation, contract proposal creation, and bid letting packaging. The detail cost
estimate for the Plans, Specifications, and Estimate package (PS&E) and bidding proposal are
two key outputs of the PES module.

Trnseport LAS (Letting and Award System) provides bid letting personnel with automated tools
to manage the plan and proposal holders lists, bid data entry, bid tabulation, low-bid analysis,
and contract award processing.

Trnseport Expedite (Electronic Bidding System) is designed to work with the PES and LAS
modules to streamline the bidding process. The Department uses information form PES to create
and distribute electronic proposal or amendment files to prospective bidders. Bidders then input
and submit their item bids in a secure, machine-readable format. The Department checks the
electronic bids for validity and data errors and then produces a file suitable for loading into LAS.
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Bid Express is used in conjunction with Trnseport Expedite. Expedite software is used in bid
preparation. Expedite is used to electronically prepare and check bids; then submit them over the
Internet using Expedite to connect to Bid Express. Bid Express is a storage site that holds the
bids until the bid date, when they are transferred to the Department.

Trnseport SiteManager is a comprehensive construction management system that encompasses
the complete construction management process, from contract award through finalization.
SiteManager accommodates all levels of construction personnel supporting activities such as
construction administration, field record keeping, contract record maintenance, contractor
payment processing, materials management, and civil rights monitoring.

Designer Interface Design consultants and others enter category
and Item detail at project level.

v

£ PES )| LAS DSS
A >, | SiteMgr

Project Development / Bid Letting Bidding Patterns
Proposal Creation Bid Analysis Construction Vendor Activity
Award Subcontractors Pricing Behavior

= m— Payments Bid History
Contract History

Electronic

Bid Transfer

r— Expedite
CES
‘ Electronic Bid
Engineer’s Estimate Preparation

Figure 1 \ 4

<
<

Document Availability.
This and other Trnseport documents are available at the following URL:

http://www.dot.state.fl.us/construction/trnsport/Maint%20Sm%620Users/trng manual/
Main%20Menu.pdf

Or you may access them from the Trnseport web site.
e Click User Guides.

. PES, CES, LAS, SiteManager User Guides
e Click TmS'DOFt Document Menu. Trnsport Document Menu (in FoF Farmat, get the newest POF
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Assistance

For assistance with Trnseport modules use the process shown below. If you need functional
assistance contact your supervisors, District Application Coordinators, Central Office
Application Coordinators, or the Trnseport Coordinator. For technical assistance begin with your

district help desk.

End user has a
problem

Is the problem
technical or
functional?

User submits Help
Form to District
Help Desk from

Trnseport Website

Call District Application
Managers (Listed on the

Trnseport website)

Can the
problem be

resolved?

Application Manager should
contact the Central Office
Functional Application
Coordinator or the Trnseport
Suite Coordinator

Can the
problem be

resolved?

(-

4

_

A

Trnseport Problem Resolution

Can the
problem be
resolved?

I

\ 4

A\ 4

A 4

District Help Desk (not
user) should Assign to
CO Help Desk

Can the
problem be
resolved?

Contact BSSO

Application
Support Analyst

A

Can the
problem be
resolved?

Contact InfoTech
submit TMR
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Getting Started

Logon to Citrix Metaframe

Trnseport is supported through the Citrix Secure Gateway. The applications execute on a Citrix

Metaframe server.

Access to the Citrix Metaframe server is via the Internet when away from the Department, or the
Intranet when accessing it from within the Department. Either way, access will then be through
the Citrix Web Interface for MetaFrame Presentation Server.

Prior to attempting a log in, the Application Security Coordinator will have assigned a Userld
and password for access to the proper Citrix Metaframe Group.

From your browser, enter:

https://fdotnfuse.dot.state.fl.us/Citrix/Metaframe/default/default.aspx

The Citrix Login screen will
open.

For quick access to Citrix,
create a shortcut for the
desktop. From the Login
screen,

e Rclick to see the Mouse
Button Menu.

e Click Create Shortcut
as seen below.

Back
Forward

Save Backaround &s, ..
Set as Background
Zopy Backaround

Set as Deskbop Ibem. ..

Select Al
Paste

Create Shorbcut

Add to Favorites, ..
Wiew Source

Encoding 3

Print
Refresh

Properties

2 Motal rame Prosentation Server - Microsaft Internet Fxplarer

Be ERt Wew Favrtes Dok teb ir
Qe - ) 8] B 0 s Srrooee £ ik B @ 3
Ak | 8] hetps: fdotrfuse dot stabe FLuspOtriMetoFrame def sultjdef sk sz - .(‘. L3
rakdobe - Y - = ][ ok Wb [ +] 8% search This s2e o7 - - | P Bockrks .
AN A
Web Interface for Ci'l'ltl X
MetaFrame' Presentation Server ]
i | Welcome
Lagin o)
Please log in
[T——
Ta log in ta Metaframe Presentation Server, enter the credantials required, and then
Paswnnrd:
Comun: syst
Log b
&l oo B N Local vt

Microsoft Internet Explorer x|

This message box
will open.

A shortout ko the current page will be placed on your deskkop,

Cancel |

e Click ok, and this icon will be
on the desktop.
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At the Login screen, Login (7))

e Enter the Userld,

Usermame: Iaprojmgr
. Password, and Password: I...nu
. Domain Domain: |c0|

. Lag I
Remember that passwords expire every 65 days.
The first time you log in, and as Citrix software is upgraded, you will receive a prompt to install

Citrix software. Respond yes and follow the installation prompts.

Logging on to SiteManager

YOUI’ CItI’iX Screen Wl” be 'aMl.-rafrmPrmmalinnSErH:r Micrasofl Internel Explorer "
similar to this one, but Will only [oe - 5« 2 6 s i @ b 5 s "
include the applications you e T T T Semin SERE .
have been authorized to access. Web Interface far CITRIX' ]
. M F “ P tati S 0
TO start SlteManager, etaFrame' Presentation Server
Applications Fe ) ©) Welcome
Y DbICI ick the o B MetaFrame Presentation Server aApplications
i i D Sine i b ke bt Mo
SIteManager ICOn SiteManager| E“a-..'.‘;d-ie r@._iw.lw |§ Eg:l 58, tl’-l:l h pE! launch an application
- . Options "r'. o5 Aiefi
The Slteremager Login & o oy B
WI ndOW WI I I open " w m‘;‘;seertles o The Massaga Cantar n.-:|:|lay< any .nn.f;.'mal.:nal ar aror maseages that may
. . . . D & ocour,
SiteManager is case sensitive. 9 & b
Your Userld and password B F
must be entered in the correct - — %]
] pone B N Lol intranes

case. The system recognizes
the difference between upper and lower case characters.

SiteManager Logon If you do not need to change your password:

- e Click the Logon button.

SiteManager . o
N T Commem st e ga.sa If you are logging in for the first time or your password has been

T e reset, the login screen will look like this. Only the

Password: [ i i -
| buttonwillbeactive:
Connect to: [Server -
Logon |  Change Passwmdl Close | ° Cl |Ck the Change
Ty porl
™ Download RTF Templates P -
assword button. SiteManager
i e Tt SheManpcer o e wadarates o \ Consinicion Management sysiem "3 6
A Assnciation of State High d T tation Olfiiak
Potions Copyiht & 20002006 AAHTD. Pations Coppight & e Enter your Old
1994-2004 Info Tech, Inc, User |1D: |[AERTNE
Password.
[Erter the User Password. Password: I
Connect to: |5 erver -
e Enter your New ! =
y Logon | Change Paxswuldl Close |
Password. (At least four characters but no more then PP —
elg ht.) BASHTO Trhe-part, the AASHTO Trne port logo, Ting-port SiteM anager,
and the Tine-part Sitetdanager logo are reqistered trademarks of the:
American Association of State Highway and Transportation Dificials
H H Portians Copyright © 2000-2004 AASHT D, Partions Copyright
e Enter your New Password in the Confirm Password e e e
field. |Enter the User Lagin Id.
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e Click ok to make the change, or EChang& Password il

e Cancel to exit without saving the new password. 01d Password: |

Mew Password: I

NOTE: If you get an Invalid Password message after two
tries, close SiteManager immediately. After the third
consecutive time of getting an invalid password
message, your Userld will be locked out. If you are
locked out contact your SM Application Manager or
Security Coordinator to have your password reset.

Confirm Password: I

1] 4 I Cancel

|Enter the O1d Usger Password,

When you login you will see this window. It is telling you that
the system is loading tables and security settings to your PC. If Local Database being Updated

during a session, your Application Manager has changed your Please Wait

- - ——
authority, you would need to log off and log back in to effect
these changes.

Next, you will see a screen that is prompting you for a security

Available Groups for kn%71we

group to use for this session. Epid Group Name :
. L. [ TDOAMSE MAINT DO APP MGR SECURITY COORDINZ
Groups are defined by System Administrators and control what @ | [FTC08M _ MANT CO &PPLICATION MANAGER
. A . B MTCOSC  MAINT CO SECURITY COORDINATOR
person is allowed to do in SiteManager. The SiteManager FTDOA _ AT DO APPLICATICH HANAGER
. R . MTDOSC  MAINT DO SECURITY COORDINATOR —
Security Manual lists the Maintenance Groups. HTDOUSERMAINT DO USER

Select the Group for the session.

A user may be a member of one or more groups, depending on
what job functions need to be performed in SiteManager.

e Highlight the desired group.
e Click ok.
SiteManager is organized with a Main Panel and a series of additional panels.

The Main Panel will always be the first FsiteMonager Pancl
panel to appear. The next panel in line C O ManPanel | Comectidvivensionts) |

. . - i W [
will correspond to the first icon presented 5 S @ W
on the active panel. Each icon represents | |smisee Rt panenity gy T
either a grouping of functions (as

indicated by the (+) or a single function.

DbIClick icons to open a panel. When there are tabs showing, you may click in the tab to open
the particular panel. If the icon or tab has a (+) indicator, another panel will open with another
set of icons.

If the icon does not have the (+) indicator, then that particular function will be launched if it is

double clicked. This usually causes a detail window to open or a report to run. To exit a detail
window you may click the x in the upper right hand corner of the window, click the |gg Close
File icon on the tool bar, or click File > Close from the menu bar. If you entered data, you will
be prompted with a message asking if you want to save the changes you made.

If the Main Panel is closed, you may re-open it by clicking File > Main Panel from the menu
bar.
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The Contract Management Life Cycle

The following figure shows the typical life cycle of a Maintenance contract in SiteManager.

Contract is transferred from LAS into
SiteManager in pending status.

l

Contract is activated in
SiteManager.

\ 4
Set up Contractor

Payment Approval
Levels

B
>

\ 4
Invoice is

received
from the
Contractor.

A 4
Daily Work Report (DWR) is entered
to record the item quantities of work
completed and verified against the

invoice.

A 4

A Diary record is created and a DWR
report is run to verify the installed
amounts.
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A

If DWR is correct, then
DWR is approved via
the Diary.

If DWR is incorrect,
make corrections.

A 4

Generate the Estimate. It will
include all approved DWRs for
that time period.

Process
datato
MMS

A

A 4

Enter contract adjustments
for that period.

A 4

Un-approve the
DWR thru the
Diary.

A

If Estimate is correct,
appropriate levels of

approval begin.

If estimate is incorrect,
delete the estimate (thru

® Estimate History

Y
Pay Contractor if
approved.

screen).
A
\ 4
Estimate is Research
approved > problem if
or rejected. Estimate is
rejected.
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Receive final
invoice.

A 4

Enter final DWR and Diary.

\ 4
Approve final DWR
through the Diary.

\4
Generate the Final
Estimate. Enter
adjustments as necessary.

A\ 4
Approve or Reject
Final Estimate.

\ 4
Enter the Physical
Work Complete Date.

\ 4
Enter any additional
dates that are required to
mark the contract
complete

\ 4
Change the
Contract Status to
Complete.
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Contract Administration

Contract Administration has three principal aspects to it. First, is the setting up of new contracts
transferred into SiteManager, second is the work associated with administration of active
contracts, and third is the maintenance of reference tables associated with contract
administration.

Similarly, there are three discreet phases in the life of a contract in SiteManager. These are:

e Transfer from LAS, initial setup of contract authority, and setup of some contract specific
information. This phase is very short and may be accomplished in one day.

e The second phase is the month-to-month work activity where the contractor performs
work, presents invoices, and the district office reviews, approves, and processes the
invoices. This phase will last for the term of the contract, and may be one or more years.

e The final phase is documenting final quantities and contract completion. This phase will
commence when the field work is completed, and may take several weeks or even
months to conclude.

The SiteManager Main Panel

As you work through the stages of a contract life

cycle, access to particular data will have different | [ Wanpanat [ Cotertbimnsiaion |
paths. These paths will always begin at the G & A W
SiteManager Main Panel. binrensrts] Pt Pt Ok ) Hematt]

For the typical District Office user, the
SiteManager application will be configured into four major functional areas, which are
represented by the icons on the main panel:

Contract Administration.

s | From this icon, you have access to the second level panel which includes functions for
Cortract

w=se|  Reference Tables, Contract Records, Contractor management, Reports, and Process Lists.
Daily Work Reports.

From this icon, you have access to the second level panel which includes functions for
wves | Daily Work Reports, Diaries, Histories, Process Lists, and Reference Tables.

Contractor Payments.

From this icon, you have access to the second level panel which includes functions for
=m0, €Stimates, Contract adjustments, Reports, Reference Table, and Process Lists

Change Orders.

From this icon, you have access to the second level panel which includes functions for
owe | Change Order Maintenance, Reports, and Process Lists.

sf+)
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Two other icons will appear on the main panel. They provide access to accessories and manuals.
Manuals are not attached to the SiteManager program.

AcCCessories.

pg | From this icon, you will have access to the second level panel, which will include
===l functions for Mail, Distribution Lists, Saved reports, System Attachments, Process lists,
and Process Status. The SiteManager Mail system is not regular e-mail, but is a means to
communicate certain actions to designated individuals. The System Attachment feature is the
means to access the SM/MMS Interface, and the Copy Contract functions.

Manuals.

The Manuals Panel indicates the User Manual, and Sampling and Testing Procedures are
sl gvailable. They are not installed at this time.

Many of the second level panels will lead to third level panels prior to opening screens into
which data will be entered.

On data entry screens, there are five icons on the tool bars that will appear repeatedly. These are
@ | Open, | Close, [ New, | ZF Delete, and | ld| Save.

Contract Administration — New Contracts

Contract Activation

The life of a contract in SiteManager begins when the contract is activated. When a contract is
added to SiteManager via the LAS transfer program many fields are transferred from LAS, but

some date, staff information, and vendor information must be manually entered into
SiteManager.

To begin this part of the activation:

Main Panel 1 Contract Administration(s] | .

'y o DbIClick the Contract
5 S = o
Contrac | [F)\anwauaa PConllacto[r] DC};ang[e] Accessoies[+]  Manuals(+] Admlnlstratlon @ ICOn On

Bl Peports(+ apments(+ rders+
the Main Panel.
ESiteManager Panel
4 Pl él' Frtoe et [ Comrmmit e DbIClick the Contract
B 2 ;

Tﬂifler?ez‘e] o MConll:itorl[] Reports [C4+]  Process List “ Records ICOn On the
— Contract Administration

Main Panel 1 Contiact Adrmiristationi+] | Contract Records(+) Pane l.

G & .
— , e 9 v oL n e DbIClick the Contracts

Projects Categories Items Cantract Contract 0SS Caontracts
Funding Authority

icon on the Contract
Records Panel.
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A detail window will open, as seen here, showing all of the contract information presented in
tabbed folder format. The Contracts window lets the user view, add, modify, or delete the basic

Contract data.

There are eight folder tabs on the Contracts window, each containing different segments of the
contract data. For Maintenance contracts, the Description, Location, Payment Data, Critical
Dates, Primary Personnel, and Prime Contractor tabs require information.

When you first access this screen, it will
be blank.

To open an existing contract:

e Click the Open|ia icon on the
tool bar.

This will open a list window that will
allow you to choose the contract that you
want to work with.

NOTE: For viewing purposes, most
screen views that follow will be
cropped to display the data in

larger format.

This screen opens sorted by contract
number. You may sort on any column by
clicking the column headers and the
screen will be sorted accordingly. When
a column heading is clicked, the FIND
filed is opened for you to locate a
contract. As you type the Contract ID, the
highlighted line will move down the list.

Open

L 44SHTO Sitabnnagy e

Fle Ede Servicss N ek

DRF? Pyl ON=p
B8 Contracts
| Descipion  Locsion PamentDals  CitcalDstes Py Peisornel * Fiine Contisctol — DBE Comet*© Trsming Flan
ContractID: NN ] Feal SL/P Paj Wl |
Status: [Fradng Puimary PTH: [ -
Districa: | - Resid Yaud: -] Field : ] h:“‘
Progress Sched: | =] Varience Pet[ 00 |~epotin
D | 1 Bath
Time Charges: | =l BmDags[ Bid Aml W
Contract Type: [Space: =l [~ Fed Dhversaght
‘Work Type: [Spsce: =] [ Local Dyessight
Proposal Fund Tupe:
Spec Ve[ Unit Syztem: *|  Suppl Spec Bk Vi AR ID:
Wage Wange Decision 10 Wage Decason Dezcnpion Geni Wy Desn 10
Decision:

B Select Contract
@Enr\lvacl o E2F50-RO
Find -
~ Contract 1D
Contract ID Vendor ID Fed State Proj Mbr Status County Lvl2 Lvi3 Lvi4 Loca +
£ora VFEIIMINNT N ATV 3 o2 FROM FRANCIS T
£orm VSSMEEZITTON N CHPL % 0z 2 175 ALACHUA 00|
001 [N [PEND i oz | [ [75ALACHUACD)
EorELA VEEMEGZITTON N CHPL = ] 175 ALACHUA D
£ VPEIIEITIIONT N CHPL » o From Primany Maint
E2F52 F593032908001 Ni& CMPL 26 02 291 S/B ENTRAMNCE F
«| | »
OK Cancel

Be sure to use upper case when typing the Contract ID.

e Highlight the contract you want.
e DbIClick it, or click ok.

The Description Tab

The following fields on the Description
tab should be populated from PES/LAS.
If they are not, populate them from drop
down list boxes:

Contract ID.

Fed St/Pr Prj Nbr. (N/A for Maintenance
contracts).

L 44SHTO Sitabnnager

Fle Ede Services Window Help

DRF? DS gl @O

B4 Contracts

© Dusciption Lugeun PameniData ~ CicslDses  Frimay Peonnel *Fime Contiacin | DBE Comet© Trsnng Flan

Contract |D: [EZr50910 Fed SUP PN T
Staws[Frrdeg 7] L E T —
District:[2 =] ResidYoed: [ =] Field:[ +] Fe
Poes chet | Veimon Pt [F bt
Diswc: [LARLE MACHINE MOWING. LIT TER REMOVAL & SLOFE MUWING ™ Balh
Time Chaeges: [CALENDAR DTS =] EwDays[ FE  BidAml 13707400
Contract Type: [Msntenane Contiact =l [~ Fed Oversght
Work Type: [Mamensce D =] [~ Local Dversight
Propossl Fund Type: [
Spee e[ 00 Unit Spstem: [Frgir »|  Suppl Spec Bk Y[ Awip:[

Wagn e Decision 1D

e Wage Decason Descriplian Tiend Wg Desn 1D
Decision:
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Status. Indicates the current status of a Contract (e.g., Pending, Active, Complete, Archived).
All contracts transfer from LAS in "Pending" status.

Primary PCN. (Transfers from LAS)

District. If the district is blank or in error, it may be entered from the drop down arrow.

Funding. (Transfers from LAS)
Desc (contract description).

Time Charges. (Transfers from LAS)

Bid Days. (If calendar day or available work day).

Bid Amount. (Awarded contract amount).
Contract Type. (Transfers from LAS)
Work Type. (Maintenance Other)

Spec Yr. (Transfers from LAS)

Unit System. (Transfers from LAS)

The following fields must be completed in SiteManager.

Resid/Yard. The three digit cost center number.

Field. (Blank for Maintenance contracts).

Wage Decision. (Will always be the 0000
Wage Decision for Maintenance
contracts).

To choose values for the fields that are
supported by code tables or lists

e Click the down arrow next to the
field.

e Click the desired selection.

Adding a Wage Decision
To add a wage decision:

e Click the Wage Decision panel to
activate it. A dark shadow will
appear around the area of the
screen that is active.

e Click the New icon on the tool
bar.

This will create an empty wage decision
record.

P 44SHTO SitaManagar
Fle Ede Senvicss Window Help
DRF?P DS g @O
© Deseripion ~ Lotsion | PaerOis © CitiedlDtes PrinayPerioel | Prise Coractss  DDE Commt ' TesnngFlan
Contract I0: [FFE1R0 Fed 5Pt Fig Nis: i
Status: [Frndng -] Primary PCH: [$102151 7506 e
Uistrick: [0 - Heaid Yok [ 250 = Fintd - | - - Fd--l
o *+ Fedeal
Progross Sched: [ Vaiance Poti[ 0 1 oyt ibrovines
D [LOFGE MALHINE MOWING. LIT1ER REMOVAL & SLUFE MOWING  Bulh
Time Charges: [CALENDAR DarsS =] DidDaye| = Bid Amt $137.074.00
Conbract Type: [Moterorce Cornact k| ™ Fed Dversght
Wotk Type: [Marrenarre Qe = [~ Local Dvesight|
Propasal Fund Type:
Spec ¥e:[ a0 Unit System: [Ergish =] SupplSpecBRYe| 200 AN
War |y e Decssmn 1D Wage Dusisn Duscogtuon Gl Wg Dgan D
Decizion:
P A4SHTO Sitabi nager
Fle Edt Servces Wndo Help
DR D gl @
il |
" Desciipion ~ Locsion  © PapmentDals  CriicslDater  PrmanyPeisonnel  Prine Contisclol ~  DOE Commd © Traing Plan

Contract 1D:; EF50A0 Fd S1/F Prj M [fa
e | Primary PN [F0T700% 2]
Distiict:[[7_~] Resid Yard [51 =] Fiedd:[ +] Fi
Progess Sohet: | Varianee Pet: | T | o
Dos: [LARGE MALHINE MOWING. LIT1ER REMOVAL & SLUFE HOWING € Hoth
Time: Chargez: [CALFNNAR 4TS =] DidDays| .  DidAme[  siw07400
Contract Type: [Marieroncr Coemact = ™ Fed Ovesight
Work Type: [Farrerance Qe =1 I Lacal Dversight
Proposal Fund Type: |
Spec Ve[ 2000 Unit System: [Ergish =] Suppl SpecBhe[ 2000 s
Wane | yage Dacision 1D Waygs Ducisun Duscuplun Gendl Wy Duan 1D

Dacision:
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When you move your mouse over the
Wage Decision field, you will see a
magnifying glass appear.

Rclick the Wage Decision field.
Click Search.

A list box of the available wage decision records

will appear.

DbIClick the “0000” wage decision.

The “0000” wage decision will appear on
the contract.

The Location Tab

The Location folder tab displays the
Contract location data that may be added,
modified, or deleted. Authorized users
may add and remove counties to the
Contract.

A primary county must be selected.

Every field except the Town field on the
Location tab is transferred from LAS. If
the data was entered in PES/LAS, you
will see it here.

P 44SHTO Sitamanager

Fle Ede Services Window Help

DR ? D @ (@00
il |
© Desciipion | Locsion  © PamentDais  CrscslDates  Prmay Peisonnel ' Prine Contiacior DO Comak  TraningFlsn

Contsact 1D [CF50N0
St [Fendng =]
Ditnick: |17« Fiedd - | Fi
Progiess Sched: | Varianee Pet:[ 001
Desc: [LARGE MALHINE MOWING, LITIER REMOWL & SLOFE MOWING
Time Charges: [CALFHNAR D475 =] DidDays:| wu  DidAme[  $I0040
Contract Type: [Marieroncr Coemact = ™ Fed Ovesight

Fueed SUFy Py b |1

Primasy PCN: [ 41001317205 =]
Fosid vaer [Z51 =

Wtk Type:[Marterance liker = I~ Lucal Dversight
Propoaal Fund Type: |
Spec Y| 2000 Unit Spstem: |Crgish = Suppl Spec Dk ¥e: [ 2004 Al iD: [
Voot [\apa e | Wags Dusisun Desciplaon Genel Wy Dusn 1D
wcison Descn uzn
Diecision: o Show Detsls — -

E Search Window

X

Gen Wog Dosn Id

0om See Contr.

Cancel

P 44SHTO Sitamanager

Fle Ede Services Window Help

MR E DS gl @O
il |
© Description *  Locsion PapmentDats  CrcelDater  PrmsiyPeisonnel * Prine Conbsclor ~ DOE Comed* TrainingFlan

Contact 10: [FFFEORD
P |
Dtk [2 =] ResdVard [ <] Fied:[ =] Fi
Pragrmes Sechu. | [ ] -
Desc: [[ARGE MACHINE MOWING, UTTCR FCMOVAL 6 SLOFE WOWING |
Time Changgms: [ ALEHOAH 7075 x| BdDays[ E  Bidame|[T fimOAN

Contrach Tppe: |Mariersnce Lot [~ Fed Ovessight

Fud SL/F Py Kb [

Poimany PEN: [ 410072 700 vl

Wonk. Typm: | Masdwrisraon (b =l [~ Local Oversight
Pioposal Fund Type: [
Spec Y[ 1000 Unit Spstem: [Ergich = Suppl Spee Bk Yr:|  200: Al 1D: [

Waye [Wage Decision 1D ‘Wage Decision Description Genl Wg Dean 1D
Decizion: xort i e A

P 44SHTO Sitamanager

Fle Ede Services Window Help

MR D@ 0D

B
" Descipten  Location  PameniDiats | CicalDster s Peiionnel | Frime Contiscior ~ DOE Commt  TraingFlen
Contract 10: [EF50HD
Logatwr: [-75 ALAHLA COUNTY
I
Beg Sta Nbr: Beq Termini: [PO0000.000 Moute Nbs:
End Sta Hbr: [ Enel Teamind: {10000 000 Highway Nhe:
Road Systen: [Space: =1 Highwoy Type: [Het Ured =
Town: |
Contract County Primary County
[ETATEWIDE -
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On the Location tab, the following fields
are required for contract activation:

Location. This is a description of the
location. Two lines are available.

Primary County. Only one county is to
be marked as the primary county.

To add a county:

e Click the County box to activate
it.

e Click the New E icon on the
toolbar to add an additional row.

e Rclick the Contract County field
in the new record.

e Select the Search option.

This will open the County Code Table.

e DbIClick the County Name to add it to %

the list.

To delete a county record:
e Highlight it.

e Click the Delete icon on the
tool bar.

You will be prompted with a delete
confirmation window.

e Click No if you do not want to
delete the record.

e Click Yes if you want to continue
with the delete.

P AASHTO SiteManager

Fle Edt Services Window Help

[DRPE DS 9@ 00w E

B contracts
" Descrption Location  * PajmentData * (Cilical Dates * Primaiy Personnel * Prime Cortiactor ~ DBE Commit " Trairing Flan
Contract ID: [E4G46RD
Location: [ON THE INTERSTATE DISTRICTWIDE
[
Beg Sta Nbr: Beg Termini: [000000.000 Route Nbr:
End Sta Nbr: End Termini: [000000.000 Highway Nbr:
Road System: [Spaces =1 Highway Type: [Spaces |
Town: [
Contract County Primary County
[BROVARD v
[ETATEWIDE u

L 44SHTO Sitabnnager
Fle Ede Servioss Window Helb

ORF? OFd gl 0P

B |
" Descipten  Locetion  PameniDiats | Cicallstes s Peiionnel | Frime Contiscior ~ DDE Commt  TraingFlen
Cantiact 10: [FF51R0
Locatsor: [I-75 ALAHLS LUJUNTY
[
Beq Sta Nbr: Beq Termini: [PO0000.000 Moute Nbs:
End 5ta Nbr: End Tesmini: [P00000.000 Highway Nbs:
Moad System: | 5paces =1 Highway Typa: [Hot Used =l
Town: |
Contract C Primary County
oo ETEE F
Fiter Snarch e
ETJ\TMDE -
E Search Window il
Code ID County Name -
16 POLK
17 SHRASOTA
SUMTER
ALACHUA -
27 BAKER
128 [ERADFORD
2 COLUMBIA
0 DIXIE
kil GILCHRIST
s T Sitabdanagar
MiR% DS g@ D@
b‘ b oy
7 Descigien | Locetion | PaeeniDials | CicalDster  PrmanyPeisonnel | Piins Contisciol  DUE Comet | TranngPien
Contiact 1D
Location: [[-75 8LATHUA COUNTY
I
B Sta Hbr: Beg Tramini: [T0000 000 Foate Nhe:
End Sla Hbi. End Iu-m:lm.llll Huyhwriay Nbs:
Road Spstem [5pace: =] Highway Type: [Hei 1104 =
Towen: |
Cantiact Couny Primary County
JRLATHA i
ETRTEWRE SASHTO Sltebhanager |

_?‘/ sy ek b ket this Conrey?

S| [
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The Payment Data Tab

The Payment Data folder tab displays the
Contract payment data that may be added,
modified, or deleted. This data includes
Liquidated Damages Rate Amount,
Retainage, Estimate Generation
indicators, and Limit Amount. For
Liquidated Damages, leave the default
value of $1.0 in place.

Liquidated damages will be manually calculated and added as a contract

adjustment when they occur, so ensure that t

Damages check box is not marked. For Retainage, leave the Unlimited
Escrow box checked, however zero out all of the percentage and
amount fields on the Retainage Changes record. Retainage will be

manually calculated and added as a contract
Limit Amt and the Contract Limit Pct fields

The Primary Personnel Tab

The Primary Personnel folder tab lets the
user maintain data on the Project
Manager, and Project Engineer. It also
may identify the personnel who will
receive messages when the Contract
becomes active or falls behind schedule.

The fields required on this tab are the
Project Manager and the Project
Engineer. They may be the same person.
To populate these fields:

Rclick the field.

Select Search.

Click ok.
Or

Type the Userld in lower case letters

Select the desired person from the list.

P 44SHTO SitaManagar

Fle Ede Senices Window Help

ORE? CFd S DT

B4 Contracts
=

Locsion ' Papmont Dsts ~ CibeslDalee  Piimay Personel | Frise Corsctor | DOE Comnt | Traieng Flan

Contraet ID: E2FR0D
Generate Estl Dag:[ | Contract Limit Amt: 00

Generate Est2 Day [ Contract Limit Pet: %

HETAINAGE
[+ Uribmled Eseiom

Curent Contract Amt: [ 8157074 00
Liquidated Dam fate Ame: [ 100
[ Auto Liquidated Dam

[ Price Adimnt Ind

Mz Frcaow Al £ |

[~ Smcuritms Allowmd [ Fslain Stkpiled Ind

Hulamays Changes:

‘Woik Compl Bases
WORK IN PLACE

Ellect Date  Fol Pl Bare MaxFol  Max Aml
s o

Lump Al Toge Pel - Toge Base
0 CURRENT AR [ 3.0

of CURRENT M| |

LIOE COimim TTEIFIFIg T iarm

he Auto Liquidated tAmt [ $137.07400

e Amt: I $1.00

[~ Auto Liquidated Dam
[~ Price Adijmnt Ind

¥ Amt: I $.00 ‘

adjustment. The Contract
should be left as 0.00.

P 44SHTO Sitamanager

Fle Ede Services Window Help
) e

T e

= Contracts
Loceson

T Descigten " Pumenilals | CcalDssr | Primoiy Prie Contiacio ~ DOE Commt  Training Plan

Porsunnul

Cantract 10:
Project Manager:
Praject Engineer: [:ri72cc

ZFSRD

" Fwan

[Cahvent Thaa

Contract Designer: |
Contract Created By: [FYSTEM
Motification Recipients

Corliact $tatus Changed o Active:
[ Uaer ID: Diatribution List- | |
Wark Progreas Behind Schodule

|V User1D:[  Distribution List: [ |

Civil Rights Exception Neport Generated:
| Uaer 10- Distrbution List- | |

E Search Window

User Id

kn1djs
lkrpbibm
kn714gg
lkn208t
lkn208hg
len206th
len314it
lkn714id

Sobczak, Judi

tMolenaar, Ben

[Granata, Gary

‘oods, Thomas

Gresne, Holly
[DEACTIMATED-Holiday, Teresa
[Tiller, Roland **LEFT FDOT [SC] *

ohrson,

. Dave

Cancel

This and other search windows have sort and filter functions. To sort this window click the User
Id label and drag the scroll bar down the alphabetized list to find the user needed. For more
discussion on sorting and filtering see Appendix A.

An individual User Id or a distribution list m
Active box. Persons will be notified via SM

ay be entered in the Contract Status Changed to
mail that the contract has been activated.
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The Prime Contractor Tab

Fle Ede Services Window Help

The Prime Contractor tab displays the DRE? CSSI@[0 G0

Prime Contractor data that may be added, | e oreiss e ki oue
modified, or deleted. This data includes e P e

the Prime Contractor, contractor [T hemied  FoamveteF | MaSubomot Pt T [ Sboankacons
defaulted data, maximum Subcontract ryrspobguu S B

amount, payroll requirements, Prime e i

Contacts, and Prime Associates. The Frine Comacts R Cortat e et
Prime Contractor's surety and insurance
companies must be entered as Prime
Associates.

Prime: Azsnciates: | Assoc Vendor ID Associste Short Name Associate Type

The Prime Contractor is transferred from — EEMEEEE

Fle Ede Services Window Help

LAS, and is a required field for activation. [Terro=sts S v

) Scacec
The prime contractor must also have at Toweoim | laokn " Powais | GheuDw | FawPwina biae " OeComw | Tanori
least one address record in the vendor file. | | e rme e g ommmmemsmmn v
|—F|-Hw--d Freg in Weeks: I | Max Subcontiact Pel: | 5000 I~ Subconiacions Pad
Bankiupley Date: (000700 Banknaploy Type Des: [Spsce:
[dem Reasan: [Spaces Date: [0
Usiginal Frams Contiaclor: | [

Contractor Prime Associates
SiteManager requires that every

contractor have Insurance and Surety
- . Fée Edt Servces Window Help
Prime Associates. To add these: LI T Il s

= Contracts

e Click in the Prime Associates box | T s rememss T aRsme e S, e Te

Contract ID- FZFR0RN

to activate it. l.::lﬁm fx'bh!‘bﬂi.'l'uﬁ EIJ?WN.'IUN JOUY WALTUN FRUFERTY MO [~ Juant Venlure
. . r [~ Nequied  Freqin Weeks: [T | Max Subcontract Pet: [ 5000 I~ Subcontractors Paid
e Click the New icon and a blank Ok DU | Bunkrc Tme D oo
record will be added. [ = i
To populate this record: '
e Rclick the Assoc Vendor ID field.
° Select Search . 96 IF04R0 ACSTAR IMSLIRSNCE COMPANY

R R TFIRD FIRE INELIRANCE COMPAN

e Select the insurance company

from the list.
R |

Vendor Id

Repeat this process to add the Surety Company.

Vendor Short Name: Assoc Type

A000000000

For contracts where no surety or insurance is required,
you must still add Prime Associate records. To provide
for this there are two “dummy” vendor records in the
vendor file that may be attached as associates. In the =T
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production environment, these dummy vendor records will have Vendor Ids of

A000000000 for SURETY NOT REQUIRED
And
A000000001 for INSURANCE NOT REQUIRED
Leave all of the other fields at their default values. If the surety and insurance companies have
not already been associated to the prime contractor in the vendor file, you will need to do this

first before you may add them as prime associates to the contract. See the section entitled
Adding Vendor Associates for instructions on how to do this.

A 44SHTO Sitamanager 5

Fle Ede Services Window Help

The Critical Dates Tab S LA T - e )
The Crltlcal Dates tab dlsplays the 7 Desciton © Locsion  * PameniDais ' Ciiticsl Dates | Prima Pertonnel * Prime Contiacior *  DDE Comnt | Traning Flen
Critical Date Descriptions (Letting Date, e e i e i [ e [
Notice to Proceed Date, etc.). These pion iz ) )
dates are required by the system for the \HaPystsdDm P ¥ i

Price Adgstments Base Date D00 N N
standard Contract status reports_. _Default x -__
dates cannot be deleted or modified. T b : ; H

. i Complele D sl 00/00/00 N ]

The following dates should be entered: P Vot Corios O s N v -

Critical Date Deseription: ok Begn Dol
Letting Date. Transfers from LAS. s BRI oot

Message Teat: [

Award Date. Transfers from LAS.

Original Completion Date. If time is to be charged as Calendar Days, the system enters this date
and the user may not modify it. If time is to be charged as a Fixed Completion Date, this date
may be modified while the Contract is pending. If time is to be charged as Available Work
Days, this field should be left blank. Maintenance contracts use Calendar Days.

Adjusted Completion Date. The SM system enters this date and the user may not modify it.
This date changes when effected by Change Orders or by the Contract Adjustment function.

Execution Date. This date is required for activation of the contract.

Notice to Proceed Date. Although the Notice to Proceed date is not marked as being required to

activate a contract, it is critical to several of the processes in SiteManager and it must be entered
prior to processing a pay estimate. For Maintenance contracts, the Notice to Proceed Date

must contain the date that contract time begins.

To enter a date, position your cursor at the beginning of the field. Do not highlight the whole
field. Dates should be entered mm/dd/yy format.

e Highlight the date to be entered or corrected.
e Enter the date in the Actual Occurrence Date field at the bottom of the screen.
e Press <EnTer>.

After entering the date, if you would like a person or a distribution list to be notified when this
date has occurred enter information in the Distribution List of Recipient ID fields as appropriate.
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Change the Contract Status to Active

After all of the required information has
been entered, the contract status may be

changed to active and the contract saved.

When this happens the persons that are
listed on the Primary Personnel tab are
notified via an In-Box message that the
contract has been activated.

When the contract is saved, this message appears.

A contract may be changed back to Pending Status to update
the activation screens until a DWR or Change Order is entered.

P 44SHTO Sitamanager

Fle Ede Services Window Help

DR D gl @

= Contracts

© Description Location Pament Dats. Criical Dates Primary Personnel * Prime Contracton DDE Comme: Training Plan

Contract 10: [R50 Fed SUP Poj Wbe J8
Stalus: [T ~ | Puimary PUN: U003
it T HesdYand: BT Feld:[
Progiess Sched | Vanance Pl w
Desc:[LATIGE MACHINE MOWING, LITTET NEMOVAL & SLOTE MOWING B
Time Charges: [CALENDAR DAY BidDaws[ %5 Bid Amt: B
Contract Type: Marbensnce Corfac [T Fed Oversight

Wk Type: [Mieteriracs lhe: ™ Local Dvessight
Proposal Furd Ty [
Spec Ve[ 200 Unat System: [Erish  Suppd Spec Dk Ye[ o4 amm:[

Wage [ e Decision 1D Wage Decision Descriplion Bend Wg Desn 1D
Dacision: s Decary

-
\_1) Conkract is Successhully Activated

Setting User Authority — Office Wide Contract Authority

S If users are to see contracts across a
Moin Panel [ ookt range (Maintenance wide or district
N @ ;s X wide). They must be given office
_Eo_nlract Daily work. Pipeline and Contractor Change Civil Rights[+) M aterials .
Administration(+]  Reparts(+] Zipl+] Payments[+] Orders(+] Management{+] Wlde aCCeSS.
= i . .
Accessories(+] . Maruals(+] L DbICI |Ck the SeCU rlty
ESiteManag&r Panel Administrator T;'&-I:II icon On the
Wain Panel 1 Syslem' i lm}] ] = — Maln Panel
2 B @B B & = _ _
v sty MR Sy s Pt 589) Tomsbies) S S e DbIClick the User Security ||
T icon

5

DRr? OFsgd O0=

Caritr

M : e At the User security screen,
L T e — 2 DbIClick the Open| g icon.
Tithe: [ S5H: | Suparvisor: | .
el e e e Select the desired user.
Contsal [~ LT | Aesd¥ard| =) L — |
L DatoBase Loge ID: [ b e ks Al o [ ] C|ICk Ofﬁce Wide fOI’ eaCh
— Al g -
— — security group or all groups as

appropriate.
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If a person is to have district wide access,
choose the district from the drop down
arrow at the District box. The screen at
right shows district wide in District 2.
This district wide access allows
designated users to see contracts across a
range, but it does not grant full authority
to perform contract administration
functions

If the authority is to be at a maintenance
yard only, click the particular cost center
number in the Resid-Yard list box after
selecting a district.

Setting Contract Authority

1 44SHTO SitaManaper

e Ede Serviess W el
OREY DS g ON=%

[Sloecsecuty

Usor 00 fi2i0f  User i [otomon, dmter
Geographic Ares [osce: |
&M Seeurity llaer [ Sampier [ Tester [ Glnbal Teater [
Tithe: | SSN: [210-0000m Supervisor. |
Vendna Prent Ind: [ Vendar 10 [ VesdoPoelIDc i
Auea Engineer: [ Aetive [+ Diefault ATF Libewy: [RTFFROD. =]
Cential [ District [0 = Tesid-Yard| =] Fied [ =]

3
fstase Login I Offiee wide: Contract Aceess T
Datalase Passwond: | anon |

[ Birnup Descriplic
Jiergabin Final F stmases Enginnes

P 44SHTO Sitamanager

Fle Ede Services Window Help
DR D gl O

[Sloecsecuty

s 1 i 10 User Harwm Herrisun, Mickery
Geographic Ares [Spoces =
SM Seeurity llaer [ Sampier [ Tester [ Glohal Teater [
RETY Coitrict Fleet blarisoe] S5N; [110-00-0025 Supervisor: [ emy
Vendar Prsnl Ind: [ Vendor 10: [ WVendor Prant 10: [
Arwa Enginee:: [ Aclive: 7 Dalaull RTF Libary: [RIFFHOD =
Cembral [~ Distnct [01 = ReedYad[110 | Fimhd -
DataBase Login ID: All (I
Difice wide Contract Access [ angs 7|
Datallaze Password: AR oy |
Benup i Oifice-Wide
Corit Uil Hods =
[Corit. Diact Dllice Adiaistiaton o
IConstuckon Eeimare Aporavel GIoup
[Consinicion Trinng Gioun

|iist T Final Esfimains Erginoes

When you enter the Project Manager

Main Panel I Contract Administration[+] ] and PrOJeCt Englneer On the Prl me
N S @ Personnel tab they are automatically
DaipWork  Contractar Change  Accessories(+]  Manualsis]
fic GG Reparts(+) Papments(+] Orders(+]

ESiteManager Panel

added to the list of persons who have
authority on the contract.

tain Pansl T Contract Admini: i ) T Contract Records{+] |
b & To add additional people:
Reference I_ aErg;:;;'H Reports [CA+)  Process List .
e et e DbIClick the Contract
Administration < i
Main Panel 1 Contract Administration T Contract Records(+) ministration @ Icon on
L a2 o - | the Main Panel.
— Contracts Projects Categories Items Eont@cl E aw::‘ DSS Confracts .
A | e DbIClick the Contract
Records icon on the
Contract Administration Panel.
e DbIClick the Contract
Authority | 2 icon.
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The Contract Authority screen contains a
list of all SiteManager users appearing in
the upper panel. The lower panel shows
the access authority of the user
highlighted in the upper panel. To add an
individual to a particular contract:

In the upper panel,
e Click the user to be effected.

Use the scroll bars as necessary to find the
person.

e Click the New [ icon on the tool
bar.

A small entry window will open.

B A4SHTO Sitemanager

File Services Window Help

|mge 20|l

E Contract Authority

User Identification

it 10m
it 10
mi1 10t
it 10sh

mt110th

User ID User Name

110

No
No
it 38ae No 01
it 38ee  Chistine No 01 |
mt1 38! Law, Ellen No ol
mt1 38j iacabsen, jim No ol 1o l
Contract Authority Assignment
Group Description orr ce-wide  Contract Id Contract Description Authority  Authority 4|
ccccc Start Date End Dt

Froject Engineer 17 e

Iairtenance Estimate Approval Grou|

AINT DO SECURITY COORDINATOR]

Project Manager

\AINT DO APPLICATION MANAGER

District Manager

AINT DO LSER

<

o

QNEW Contract Group Authority ll
Group Description Contract Id Contract Description Authority
Start Date
= [ I

Save LCancel

e Select the group description for the added authority by selecting from the

drop down list box.

e Place the cursor in the contract ID field and select search from the right

mouse button.

The list of available contracts will open.
Scroll to the one needed.

e DDbIClick the desired contract.

The information in the entry box will
appear as at the right. If the information
IS accurate,

e Click the Floppy Disk |[& icon
to save the data.

If the information is in error,

e Click Cancel and make necessary
corrections.

The result will appear as in the screen to
the right. If an error is discovered after
the Save button has been clicked, the
data row cannot be deleted. The only
remedy is to end contract authority for the
particular individual.

Filter Search

Filter
Fird
Sark

Show Filber) Sork

X

Search Window

Contract ID Vendor |D
E1C36 WFEE1401476014
E1CI7 WFBS0461407001
E1C38 WFBS1EESFOE002
E1C33-RO WF34133728700
E1C33-R1 VF341 33?28?001
E1D00-RO VFE50851194002
E1D00-H1 WFEBOEE1194002

4|

Fed State Proj Mbr Status

N ACTY
A2 ACTY
N2 ACTY
N CMPL
30
A2
N2

Countp Lvl2 =

06 o
13 o —
12 ol
16 o

E New Contract Group Authority X
Group Description Contract Id Contract Description Authority
Start Date
MAINT DO USER _~lF1caar2 FROM REPAIRS PRIMARY SYSTEM TO [

Save Cancel |

] A4SHTO Sitemanager

File Services twindow Help

|mge a0l

E Contract Authority

User Identification

User ID

mtl 10
i 100
mil 10sh
mi110th
mi138ae
mi138cc
mi138el
mi1 38

Contract Authority Assignment

4l

Group Description Omnrwi\h Contract Id Contract Description Authority | Authority < Jf
ccccc Start Date End Dt
1AINT DO AP MGR SECURITY COOVTWWW’—
& Estimate Approvel Grou[ | [pD485-R1 MOA PALMETTO [r2/2004 15:20; 4\
Meintenance Estimate Approval Grou| 1E12-R0 ISC COMCRETE REPAIR 1182004 1257
14INT DO USER m ISC COMCRETE REPAIR 111872004 12:57)
1AINT DO APP MGR SECUIRITY COCH| FiE12-r0 I5C CONCRETE REPAIR 111872004 12.5
Estimate Approval Grou| t1 B84 HARLOTTE COUNTY 14412004 10:46:0 BIS/2004 15:58:

| B
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To do this:

e Highlight the individual in the upper panel.

Process Status

e Highlight the data row in the lower panel.

e Select Services > End Contract Authority from the menu bar.

YOU may Only end a person's authorlty ] 44SHTO SiteManager

File Services Window Help

after you have saved the record. ﬂ“ $2|0E0)]
Contract Authority

In this example see the authority granted
and its date and time, and the authority it ‘ :
removed with its date and time. T 5

e o T B
Offlce Wlde Access C“m::.:-::::::’i’p::ig“memof:z:;:;de Contract Id Contract Description ;-::-:];iz AIEI::inlrnity -
Each person in a maintenance yard should e s — foen s
be granted office wide access to have o =
visibility of contracts within that yard.
The particular authority is controlled by : -

the Security Group and membership in those groups.

Contract Administration — Reference Tables

The Contract Administration reference tables store the defaults and the Department- standards
that are added to Contracts. The reference table data is loaded into SiteManager from PES/LAS.
This section of the manual describes how to view and maintain the reference table data in
SiteManager.

Through the Reference Tables

e sitchianager pane! x| panel, an authorized user may
@ Main Fan.el . Ennnmmlstratmna ] m X add the fol IOWi ng Standards and
.
DailyWork  Pipeline(+] E:::ctnr Change  Civi F!_ighls[+] M aterials ‘ defau ItS to the reference tab I es:
[+) ] Papmerts(+)  Orders(+] Mamagement(+)
] = Administrative Offices,
Aoc Main Panel Contract Admil I Reference Tables[CA+) I - Fu n d i n g SO u rCeS
ﬂi = ﬂm B o _ _
Hi\;r;llrdascll L Maair;l;;:;ﬁr‘[ " Repoits [CA+]  Process List ] Vendor I nform atl On ,
X .
HMain Panc 1 T Roference TablesiCA®) | Default Key Date types,
a & H & = Default Checklist Event
= Interface Load  Administrative  Item Master  Funding Sources  Wendors Default Critical — Default Key
—_— Messages Offices Dates Dates typeS| and
g B = Default liquidated
efault Checklist efault
Events %C;L::ﬁ:g dam age rates .
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The Reference Tables panel cannot be used to add:

= Default Critical Date types.

= [Items. (These must be added through the Item Master List in CES/PES.)

The Reference Tables panel contains icons for the nine functions, but will vary depending on
your security access. Most users in the District offices will be able to view all nine of these

functions.

For Vendor information it is important that all additions or changes, including address
information be made in PES/LAS and be transferred to SiteManager.

SiteManager does not allow overwriting within SiteManager of Reference Tables loaded from

PES/LAS.

Adding Vendor Associates

B csarce s 0 = In order for Surety and Insurance
] Cotact Acriisraionts) ) companies to be added to a contract
§§ H H S B W ” as prime associates, they must first
X Daily work. Cantractar Change Accessonies(+]  Manuals(+] - - -
| mEaY | B be associated with the prime
=B . x| contractor in the vendor file.
tain Panel Contract Administration[+] r Reference Tables(Ca+) I
M B ﬂ!‘J “ To access the vendor table:
Contract Contractar Repoits [C4+]  Process List
Records{+]  Management{+) A
’ e DbIClick the Contract
SileMﬂnager Panel 5‘

Main Panel

Cantract Administration(+] T

Interface Load  Administrative  Item Master  Funding Sources|
Messages Offices

B

Default Checklist Default
Events Liquidated
Damages

W ow B W w @B

Default Citical ~ Default Key
D

Administration | g/ icon on
the Main Panel.

e DbIClick the Reference
Tables | fjif icon on the
Contract Administration
panel.

e DbIClick the Vendors| =
icon on the Reference Tables

Reference Tables(CA+)

ates ates

With the cursor in the Vendor ID field of
the Description tab,

e Click the Open| g icon.

panel.

=] A4SHTO Sitemanager

File Edt Services Window Help

|EEe g 0SS 9@ O

Accour\ls Usage

Vendor ID:
Short Name:

Full Name: [

¥endor Type: ~]  Alt Vendor ID: O

IRS Tax Nbr:

DBE Type:[Spaces =] Cert Type:[Spaces =]
Cert Date: [00/00/00 Cert End Date: [00/00/00
Cop Type:[Spaces =] Comp State:| =]
Prequal Date: [00/00/00 Prequal End Date: [00/00/00°
Uncompleted Work Amount: [ 000 [ Preconstuction Indicator [ Obsolete Ind
Ethnic Group: [Spaces Gender|
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This may take a while to load, as the = =
vendor file is large. When the vendor list | geeston

opens, you may select the desired Vendor
by,

e Scrolling through the list, or

KING OF PRES EINC

'/FE5081766901 PROSCAPE SOUTH EAST

. . \VFS306815230 SLACK &JOHNSTON, INC. Constiuction Contractor
[ SO rt by CI | Ck' n g 0 n a CO I u mn /65082262400 B.A.T. CONSTRUCTION, INC. Construction Contractor
\VF 38236956701 A4 PAVING INDUSTRIES INC Constiuction Contractor
M M M M WF38318573200 ROESE, . C. CONTRALCTING, INC. Construction Contractar
h ead I n g and us I n g F I n d fl e I d y Or F3907983600 BETTER ROADS INC Construction Contractar
- H 0K Cancel
e By creating a filter =

For a further discussion on the use of filters see Appendix A..

Since the Vendor ID is 14 characters, it is

not fully visible in its column. rf
Click the line between the label Vendor
ID and the label Vendor Short Name.

k. ING OF PRESSLIRE INC
WFEGORT7ERS002 |PROSCAPE SOUTH EAST

When the cursor becomes a two headed

arrow, drag the lin to theright o make | [E25 FTE
the Vendor ID column wider. (e e — _
By double clicking on the Vendor Short 0k | Conce|

Name Label, the column may be sorted alphabetically. The Vendor Name may then be found by
scrolling the list or dragging the scroll bar. In a similar manner, Vendor Id column may be
sorted and scrolled.

Alternatively, a vendor may be located [ vcnmorpcciin i

using the SiteManager filter [
e Rclick on the Vendor Short
Name label. e
it B 2
e Select Filter from the pop up iroosrasme
menu. e o Eontct
V741185584001 e e ot [etuetion EZ:::Z:Z:
e Click the Add tab. E
0K Cancel
One row will be displayed to select your
eiunind Y x
search criteria. For this search: _ — :
Field Condition Yalue Join Inzert
° ChOOSG Ven dOF Sh ort N ame in th e |*/endar Short Name | |Like | COUCH CONSTRUCTION] Add
. Remove
Fleld BOX Clear
e Choose Like in the Condition Lost
Load...
BOX' Save
e Enter the characters “COUCH ”
CONSTRUCTION" in the Value p—
Box. Mol
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Notice that the search is in uppercase letters. Search functions in SiteManager are case sensitive.

e Click the ok button on the right side of the window.

A message box is returned indicating that this filter will return Filter Message

five rows.

e Click ok.

From the rows returned:

e Highlight the combination of
Vendor ID and Vendor Short
Name desired.

e Click ok.

The vendor record will open.

NOTE: Any changes to vendor
information other than
Associates should be made in
the vendor table in PES/LAS.
New vendors should also be
added in PES/LAS and not
directly into SiteManager.

These Vendor Table changes will be
transferred to SiteManager during the
nightly update process.

To add an associate record:
e Click the Associates tab.
e Click the New [T icon.

e Rclick the Associate Short Name
field and select Search

Or

e Enter the Short Name if you
know it.

@ Specified Filker will rekurn S rows

E Vendor Pick List

S elech
ﬁg—_.\u’endor
Find = |

i Vendor

Yendor Id Wendor Short Name Vendor Type

YFE30353742001 COUCH COMSTRUCTION COMPAMNY Construction Contractar
WFE31183808003 COUCH COMSTRUCTION LP Construction Contractar
YFE31183808006 COUCH COMSTRUCTION LP Construction Contractar
YFE31183808002 COUCH COMSTRUCTION LP Construction Contractor
WFE: COUCH CONSTRUCTION, LP. Construction Contractor

0K Cancel

File Edit Services Window Help

Description “woik Classes ©  Affiiates  ~ Personnel  Prime Contacts” Associates  Gecurity Secuities
Accounts Usage
Yendor 1D: [VFE31183808001 IRS Tax MNbr: [FE31183808

Short Name: [COUCH CONSTRUCTION, L.
Full Name: [COUCH CONSTRUCTION, LP.

WVendor Type: [Constuction Cortractor AltVendor ID:[
DBE Type: ISpacss Cert Type: lDlher—
Cert Date: lm Cert End Date: W
Corp Type: |Co-Partnelship Corp State: IDE—
Prequal Date: W Prequal End Date: lm
Uncompleted Work Amount: l—UUU ¥ Preconstruction Indicator I~ Obsolete Ind
Ethnic Group: |5paces Gender: l—

3 AasHTO Sitemanager

File Edit Services Window Help
mREg | DS O
Vendurs

Descrplion *wiork Classes *_ Affiistes * Personel Prime Contacts Associates | Secuity * Sscuiiies
Accounts Usage

Vendor ID: [VFE31183808001 Short Name:  |COUCH COMSTRUCTION, LP

Associale Short Name Associate Type I
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When the list of vendors appears again,
perform a filter and look for the vendor
record you want.

Surety and Insurance Associates

SiteManager requires that every contractor have

"Surety" and "Insurance Associate”. If by

contract conditions, none are required, select the

two dummy vendor records:

A000000000 for SURETY NOT REQUIRED

And
A000000001 for INSURANCE NOT REQUI

In this example the filter is set to Vendor Type,

Like, and Surety

Highlight the record you want.

Click ok.

After the associate records have been added

e Select the appropriate Associate
Type for each record from the list
box. (“Surety" and "Insurance".)

e Click the Save icon on the tool bar

to save these changes.

Once these vendors have been associated
here in the vendor file, the associates will
be available to add to any contract as
prime associates.

ESearch Window E

Yendor Id H

¥endor Short Name
City of Mary Esther
ABCO INDUSTRIAL PAINTING

Yendor Type

City Gavernment

Construction Contray

CODB1B003  AMERICAN DISTRICT TELEGRAPH COMPANY Constiuction Contra =
CO00428608  ALAD. CONSTRUCTION CO Constuctior Contta  Show Detalls
CO00702108  AARON FEWCE COMPANY Constuction Contra —
COD2081008  AIMEE CONSTRUCTION COMPANY. INC.  Constuction Contra
CO02316008  AIRPORT MARKIMNGS, IMC. Construction Contra Find
CO02433008 Al COMSTRUCTION IMC Constuction Contra sart

Shiowy Filter) Sort d

0K I Cancel |

EFilter Criteria - New Filter

Field Condition Insert

=iftke =] :Surety

Value Join

[Vendor Typs Add

Remove

Cloar

Test

Load...

Save

0K

Cancel

RED

Help

E Search Window

Short Name
WY MAINTENANCE CO.
LETTER OF CREDIT USED [N LIEL OF SURET Surety

Vendor Type

VFE51037368001 SAFE ELECTRIC CORP. Surety
/F135379520001 SEABOARD SURETY COMPaNT Surety
4000000002 SURETY & INSURANCE ARE THE SAME Surety
4000000000 SURETY NOT REQUIRED Surety

0K I Eancell

B AASHTO Sitebanager

Fle Edt Services Window Help

R LR T

Secuties
Usage

Description ~work Classes © Affliates ~ Personnel | Prime Contacts Associates

Secuity
Accounts

Vendor ID: [VFE31183208007  Short Mame: [EOUCH CONSTRUCTION, LF.

Associate Short Name

INSURANCE NOT REQUIRED

Remember that SiteManager requires that every contractor have at least two associates.

One for "'Insurance™ and one for ""Surety’
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Daily Work Reports

Daily work reports (DWR) are the means to record work in SiteManager. For Maintenance
contracts, a DWR will be completed for each invoice that is submitted by the contractor. The
DWR will encompass all of the work that was completed and verified within the invoice period.
The contract terms will specify the frequency for invoicing and payment. If the invoice is
submitted monthly the work recorded will be for the entire month. If the invoice is submitted
quarterly the DWR should reflect the work done for the entire quarter. If the invoice is
submitted against a work document the DWR should reflect the work done within the time
specified on the work document.

To create a DWR:
Main Panel 1 Daily Wark Reports[+) 1 A A
& S Fq e DblClick the Daily Work
NCCREE Reports||£]| icon on the Main
Panel.
Main Panel 1 Daily Work Reportsi=) |
I e DbIClick the Daily Work
k Diary Histary Process List Reference .
e Tables(DwR+] Reports icon.

The DWR panel contains six tabs for
entry by topic. They are DWR Info,
| Contractors, Contractor Equipment,
Daily Staff, Work Items, and Force
Account

DWR Info. Tab Blsmme

Fle Ede Services Window el
mME % Do om

If you have been working with a contract, |
the DWR will default to open a DWR for | "= = === mme oome o i
the contract you have been working with. o Dot [ 77,
The DWR Date will be the current date. s O — -
Authonzed Date: [JUT000 Lem| 0 2 [ =]
If you have not had a contract open, then PR VA o s et
the Contract 1D field will be blank and the e | Reemmatem [ @0
DWR Date will still be defaulted to the ‘ " 3
current date. -
Best practice will be to always open a new DWR form.
To create a new DWR:
) )
e Click the New|[ ] icon on the tool bar. @ e e
You may be asked if you want to save your changes or not, click w | o |

NO otherwise you will create a DWR for the contract that is open
and for the current system date.

Always exercise care when switching between contracts to avoid an accidental "*save™ that
creates an unwanted DWR. DWRS cannot be deleted.
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To open an existing DWR,

Inspeclor

e Click the Open | icon

e Click Contract Id in the upper P |

i~ Contract ID

panel Contract ID

dor Desciiption

Lvl2 Lvl3 Lvl4 =

s ||

Fed State Proj Nbr
042300410
07550671

o113 17
R . 21103 FR40915605002 0951557 ACTY  SARASOTA 01 108 Al

[ ] b I C I k h C h 21143 F532651115001 1001047 ACTY  HENDRY o 1. sk
D IC t € OntraCt In t € 21145 F532319514002 N ACTY  HIGHLANDS 01 106 FF

21300 VFEE1401476007 N2& CMPL  BROWARD 04 412 FF
lower panel N | o
ok Cancel

e DbIClick an Inspector Name
- @ Inspector
(Userld) in the lower panel

Find - |
i~ Inspector
User ID Inspector Name: Contract Id
- ﬁ
kn20Bdh Hardin, Diane E2F37
k208wt ‘Woods, Thomas E2F37
kn208tw ‘Woaods, Thamas-D0 NOT USE E2F37

e DbIClick the DWR Date. iRl

E;:'\l:;:l 1o E2F37 L WF3R1035114001, MAA
NOTE Only the person WhO Created a Inspectar kn208hg , Greene, Holly, E2F37

@ Date
DWR may change it.

Find - |
~Date
DWR Date  Locked Auth Ind

06/18/03 No Ves
05418/03 Mo ‘ex
05/17/03 No Tes
0516/03 No ‘Yes
0541503 Na ‘es
06/14/03 No Ves
05/13/03 Mo ‘ex

oK Cancel

You may also open DWRs through

commands on the menu bar: 7 iy T ——

[, B
(" F sihfer] i Dy Stall ‘wotk linma Y Focedccounls
Contract
e Click Services > Choose Keys : = —
from the menu bar. J fk:w ”;: g | =
Freview Ds Chii+Shft+y e I-
T i Suspended Tme. (L1 ﬁ
No Daly Stall Un Sile: Iz Hesumed T (LT ﬁ
Remaks: d

A list box of active contracts will open.

ECunlracl D
(7= Contract [0

e DDbIClick the contract you want.

e Click ok o |

~ Contract ID

Contract ID Fed State Proj Nbr

dor Description County Lvl2 Lvl3 Lvl4 =«

S G
POLE m 180 e

1POT0&R0

A
1POT0ERT WFES1640418001 N FOLK o 180 (i
20334 VFE50394050001 04230040 ACTY  SARASOTA mo 10 FF
21102 WF720536353001 07550671 ACTY  CHARLOTTE 01 113 17
21103 Fe4091 5605002 03515570 ACTY  SARASOTA ol 106 Al
< | »

0K Cancel
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The DWR Info tab will appear.

The contract number will then show in the
Contract ID field.

The Inspector name will be filled

The date will be the current system date.

To open a new DWR,

e Click the New E icon on the tool
bar.

This will set the DWR Date field to
00/00/00.

For Maintenance contracts, you will want
the DWR Date to be the date work was
completed on the contractor invoice. If
you do not type over the DWR Date then
you will end up with a DWR having the
current date for the invoice period end date.

You may want to enter the period that the
invoice spans in the General Remarks
area so it will be clearly stated. Remarks
are NOT required.

To enter the remarks,
e Click General
e Type in the remarks

e Click General again to set the
check box.

L 44SHTO Sitabnnager
Fle Ede Serwces Window

ek

DR DS @OE

W4 Daily Wark Reports
WA Info.

Corlractors

Contract I0: FI071AZ

Corirachor Eouin.
Inapector:  [Eonno. Wilkm
DWR Date: | 1071705

Doy Sl

ok lieme:

T o R

Locked: fio
Authonzed: o

Authosized Date: G700/

Temperatuse:

Lol L

wign:[ T 5
Low | 0 2

Ho Wk ltems Installed: [+
Nu Conliactors Un Site: [+
Mo Daily Staff On Sitec [+

Work Suspended: [
Suspended Time: onog 3
Reosumed Tima: [5T77) :_.ﬂ

bl Weathe Doscip
Claim Iszuns

Nemarks:

=l

P 44SHTO Sitamanager

Fle Ede Services Window Help

Ml E DESEAm

=4 Daily Work Reports

DWH Infa. Tortmactor Conacte Eqip. Dhaily Stall Wtk linma " Focsdccomls
Combeaet 10 F1071AZ Izt [Connn, Wilkam
DWH Date: [ FO0010
Locked: fin Tempesature: Weathes Conditions
Authogized: fin wighe| U = am:l =l
Authorized Date: PG00 Low| U 3 P =l
[ Mo Work Homs Installed. & Work Sumpended: [
Mo Contractors On Site: [+ Suspended Time: [ =
Mo Dasiby Stalf On Site: [ Resumed Time: [ 0000 =
emarks:
E
=l

L AnSHTD SitaManapar
Mo Ede Services Window |

felp

ORF? DFeEm@

E= A Dafty Work Reports

DWR Infa. Conltaciis ~ ContociuEqép Doy Shalf Y Waklems 7 Forodecounts
Contract 1D ETO7T A2 Inspeetar:  [Forece, Wik
DWH Dake [ 1071575
Locked: i Temperature Weather Conditions
Authorized: fia igh:| 1T = el =]
Authorzed Date: D000 | 0 = Pl |
Hao Wark liems Installed: = Wtk Suspended. [~
Hu Conbiactors n Sie: = Suspended Time: [i1e1] ?_‘
N Diasky Stadl Un Site: = Husumed Time: wm =
Remarhs:
E rrvmmenlal =] [Tepe remaks| =
|
M o Lralls: | ;

You will not be entering the Temperature or Weather Conditions for Maintenance contracts.
e Click the Save icon to save the DWR Info.
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Contractors Tab

NOTE: You must select the contractor
for the DWR before you will be
allowed to record any items.

To add a contractor

e Click the New|[ icon. This will
add an empty record.

e Click the down arrow in the
Contractor field

e Select the contractor.
e Leave the other fields as zero.

e Click the Save icon to save
your changes.

If you did not click the Save icon and
attempt to go to another tab, you will be
prompted to save your changes before
going to another tab.

P 44SHTO Sitamanager
Fle Ede Servioss Window Helb

ORI CEgd @
By woncrpors
7 DWRInin " Contactes " Coemachu Equp. Dy Stall T Woik linma T Foicn eeounts—

Contract ID: 1071 AZ Inapector:  [Eoanor Wikam Diades: [ITATRIE

Hix of
51 inrs

sonnel Type

P 44SHTO Sitamanager
Fle Ede Servioss Window Helb

ORI CEgd @
By woncrpors
7 DWRInin " Contactes " Coemachu Equp. Dy Stall T Woik linma T Foicn eeounts—

Contract ID: 1071 AZ Inapector:  [Eoanor Wikam Diades: [ITATRIE

Hix of
5 ianrs

Lontaclo

VFES102E063001 MEM CONTRACTOREMC. “PRIME™  MiM CONTRALT

Hhe af
Persons

Totad
Hours

Hows

sonnel Type Worked

For Maintenance contracts, you will not enter data for the Supervisor/Foreman, Personnel
Type, Contract Equip, Daily Staff, or Force Account tabs.

Work Items Tab

The next tab to work with will be the
Work Items tab.

e Click the Work Items tab label
to open it.

The Work Items tab lists all of the pay
items on the contract by FinProj Number
and Category.

To enter the installed or invoiced quantity
for an item,

e DbIClick the item.
Or,
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e Highlight the Item,

e Click the Record Work ltems

@ icon.

When the item selected appears on screen,

e Click the New icon on the
tool bar.

Enter data in lower panel for the Item
described in the top panel.

e Click the Placed Qty field, and
enter the quantity for the current
period.

e Tab to the Contractor field, and
select the Contractor from the
down arrow.

e Tab to the Location field and enter
a name you have assigned.
(Various, SR100, etc.)
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